JISANG ELECTRIC Co.,LTD
DH,DHD-Series
JISANG Rectifier

Supported version TOP Design Studio V4.0 or higher {Rl
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1. System configuration
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The system configuration of TOP and "JISANG Electric Co. — DH, DHD-Series" is as follows:

Series CPU Communication method System setting Cable
3.1 Settings example 1 5.1. Cable table 1
RS-232
DHD-R50 Page 4 fPoge 11
DHD-R100
DH-R50
DH-R100
DH-R200
DHD Series DH-R300 3.2 Settings example 2 5.2. Cable table 2
DH Series DH-R500 R>-422485 (Page 6) (Page 12)
DH-R1000
DH-2000B
DH-30008
DH-50008

W Connection configuration

+ 1:1 (one TOP and one external device) connection — configuration which is possible in RS232C/422 communication.

1O

Lo
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2. External device selection

TOP
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H Select a TOP model and a port, and then select an external device.

MINEBEA Co., Ltd,

Azbil Corporation

KOROQ TECHNOLOGY
ROBOSTAR

Ebmpapst

CoDeSys Automation Alliance
Ophir Optronics Solutions Ltd.
SERVOMEX

Tiger Optics, LLC

B &R Automation

Peripheral Device

OTHERS Manufacture

Select Device n
PLC select [COM2]
e [ g S
@ Model (O vendar
Vendor Model
FAMNUC Co., Ltd, &

~
& OKY : DVC
& ILSHINEIO : FD FRONT

& SHINSUNG E&G : MCUL32 Series

& SPEEDTECH : PUI-2000 Series

& ASN @ T8H Sensor
& SNC : Flow Meter
& SEORIM : PMC3000
& MEMORY MAP SLAVE
& WILLINGS : Master+

& SAMAHN TECH : Digital Air Speed Meter

& 5 TEC : MUX

v

.
. Eack | B Next ® Cancel
Select Device [ = |
PLC Setting[ JISANG : Rectifier ]
Alizs Mame : [PLC1
Interface : | Computer Link 4
Protocol : |Rectifier Link ~

String Save Mode @ |First LH HL Change

[ use Redundancy

AND v
TimeQ ] 5 -
0 =
Condi i
Primary Option
Timeout 300 =l
Send Wait msec
Set Voltage (LIS O 2lE)
Set Current M atcH - |000 Bl
Set Status (LIS O 2lE)
@ Back o OK ® Cancel
Settings Contents

TimeOut (ms)

Response latency after frame request by TOP device

SendWait (ms)

Wiaiting time prior to frame request by TOP device.

Station No

Target communication device's identification number

Set Voltage

Configure the voltage address for the rectifier

The address configured for the target communication device by the TOP

The state in which non-volatile data is held by the TOP device by configuring to
“LATCH".

Set Current

Configure the voltage address for the rectifier

The address configured for the target communication device by the TOP

The state in which non-volatile data is held by the TOP device by configuring to
“LATCH".

Set Status

Configure the status address for the rectifier

Requested status value (1: Current settings, 3: Voltage settings)
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3. TOP communicat

ion setting
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The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting

M [Project > Project Property > TOP Setting] — [Project Option > “Use HMI Setup” Check > Edit > Serial]

— Set the TOP communication interface in TOP Design Studio.

Project Option

- Change HMI[H]

R Ao PLC ST Change PLCI

t {3 TOP Setting !
B 520X

+ -l Option Module Setting

Date [ Time Sync. =~ Screen Option

Screen Change

Project Option

E3 Delete PLCD)

Unit Convert

HmiSetup = Global Lock & Touch

Project Style | Splash

PLC Buffer Sync.

-l FieldBus (0)
-4 RFID {0} Use HMI Setup I_ |
e c"[::vzgiiﬁggf a - Initialization Edit
v oW CoM2 (1) Project Setting ~
- PLC1: JISANG : Rectifier HMIDisable=0
g COM3 (0) zgﬁﬁ:daerla’;;iw project
o S Star Sreen o 1
48 USBDevice (0) Latch Set=0n0
Communication Error Message =0
USBErrorMessage=0
StorageErrorMessage=1
DatabaseMessage=1
Caontrol Panel
System m Devices L4 Service =% Option
s Serial —
.
T v Serial Port:  COMZ -
PLC Security Date/Time Signal Level
() RS-232C () RS-422(4) (@) RS-485(2)
Baud Rate: 38400 o
o o e
I ol &/ Data Bit: & -
Et hernet Serial HOK | Stop Bit: i -
— Parity Bit: None v
- : % Flow: [ff
Wi I S5 )
. . e . Auto Search  Loopback Test
Diagnost ic File Fing
Manager
Apply | Cancel
Items TOP External device Remarks

Signal Level (port)

RS-232C/RS-485

RS-232C/RS-485

Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE

* The above settings are examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting

M [Project > Project Property > Device Setting > COM > “PLC1 : Others]

— Set the options of the “Jisang : Rectifier"” communication driver in TOP Design Studio.

Project Option

- Change HMIH] “ Add PLC[A] | THiTal Change PLCICl | [ Delete PLCID)

~ [} TOP Setting

#8 Option Module Setting
- FieldBus (0)
-8 RFID (0)
g% Device Setting
g COM1(0)

~

COM3 (D)
Ethernet (0)
Wireless (0)

I— PLC1: JISANG : Rectifier

PLC Setting[ JISANG : Rectifier ]
Alizs Name : [PLC1

Interface : | Computer Link ~

Protocol : | Rectifier Link ~
String Save Mode : (First LH HL Change

[ use Redundancy

T
5]
4

Primary Option

Timeout 200 &1 | msec

Send Wait msec

Retry 5 =
Set Voltage LATCH 000 HiS
Set Current LATCH v |00D B :-j'u
Set Status LATCH 000 HIS
£
Apply Close
Settings Contents

TimeOut (ms)

Response latency after frame request by TOP device

SendWait (ms)

Waiting time prior to frame request by TOP device.

Station No

Target communication device’s identification number

Set Voltage

Configure the voltage address for the rectifier
The address configured for the target communication device by the TOP

The state in which non-volatile data is held by the TOP device by configuring to “LATCH".

Set Current

Configure the voltage address for the rectifier
The address configured for the target communication device by the TOP

The state in which non-volatile data is held by the TOP device by configuring to "LATCH".

Set Status

Configure the status address for the rectifier

Requested status value (1: Current settings, 3: Voltage settings)
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3.2. Communication setting in TOP
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* This is a setting method when "Use HMI Setup” in the setting items in "3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

M [Main Screen > Control Panel > Serial]

Items

Bun

YHC
Yiewer

Ethernet Serial
——

E =

Diagnost ic File
Manager

Conitroll Panel

Serial

Serial Port

Signal Leve

() RS-232C O RS-422(4) @

;| come -

Baud Rate:
Data Bit:
Stop Bit:

Parity Bit

Flow:

3 [ Mone

| Of f

lAuto Search] lLoopback Testl

 Aeply | Cancel |

[System]

TOP

Close r

|

External device

Remarks

Signal Level (port)

RS-232C/RS-485

RS-232C/RS-485

Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE

* The above settings are setting

examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting
M [Main Screen > Control Panel > PLC]

Run

YNC
Yiewer

Screen
shot

@ System Driver(0OM?) [PLCNJISANG e e v]

Interface | Computer Link R
i Protocol | Rectifier Link R
PLC Timeout 300 |3 msec

Send Wait msec

["_"-] P
(1

station Mo =

i
[«

Et hernet
2et Yoltage LATCH: 000: 16: 16: DEC: RiY
m 2et Current LATCH: 000: 16: 16: DEC: RiY
aet Status LATCH: 000: 16: 16: DEC: RiY
Diagnost ic
-
[System] [ Diagnostic HCanceI]

" el

Settings

Contents

TimeOut (ms)

Response latency after frame request by TOP device

SendWait (ms)

Waiting time prior to frame request by TOP device.

Station No

Target communication device’s identification number

Set Voltage

Configure the voltage address for the rectifier
The address configured for the target communication device by the TOP
The state in which non-volatile data is held by the TOP device by configuring to “LATCH".

Set Current

Configure the voltage address for the rectifier
The address configured for the target communication device by the TOP
The state in which non-volatile data is held by the TOP device by configuring to “"LATCH".

Set Status

Configure the status address for the rectifier

Requested status value (1: Current settings, 3: Voltage settings)
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3.3 Communication diagnostics

W Diagnosis of whether the port communication is normal or not
- Touch "Communication diagnostics” in [Control Panel > PLC].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system oK NG ) )
) ) - 1. System configuration
configuration Connection cable name OK NG
TOP Version information OK NG
Port in use OK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
) ) OK NG . .
diagnostics 3. Communication setting
Serial Parameter Transmission
oK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
External device CPU name OK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings oK NG ) )
4. External device setting
Serial Parameter Transmission
oK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
OK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

Refer to the vendor’s user manual to identically configure the communication settings of the external device to that of the TOP.
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TOP 225 -
5. Cable table

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device.

(The cable diagrams described in this section may differ from the external device vendor’s recommendations.)

W RS-232C (1:1 connection)

COM PLC
Pin Signal Pin Cable connection Signal
arrangement*Note 1) name number name
CD 1
1 ] RD 2 D
Q Q
6 9 DTR 4 DTR
Based on SG 5 SG
communication DSR 6 DSR
cable connector RTS 7 RTS
front, CTS 8 CTS
D-SUB 9 Pin male 9

(male, convex)

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-422 (1:1 connection)

[@e]Y/ PLC
Pin Signal Pin Cable connection Signal
arrangement*Note 1) name number name
RDA(+) 1 SDA(+)
1 5 2 SDB(-)
© © 3 RDA(+)
Q o RDB
6 9 RDB(-) 4 )
Based on G > G
communication SDA(+) 6
cable connector 7
front, 8
D-SUB 9 Pin male 9
SDB(-)
(male, convex)

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-485 (1:1 connection)

COM PLC
Pin Signal Pin Cable connection Signal
arrangement*Note 1) name number name
RDA(+) 1 SDA(+)
1 5 2 SDB(-)
© © 3 & —| RDA(+)
Q © RDB
6 9 RDB(-) 4 ()
Based on G 5 G
communication SDA(+) 6 —*
cable connector 7
front, 8
D-SUB 9 Pin male 9
SDB(-)
(male, convex)

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
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6. Supported addresses
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The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the

address range supported by the device you want to use.

Command | Bit address range Word address range Description
VOLTAGE - VOLTAGE Voltage data received from target device
CURRENT - CURRENT Current data received from target device
STATUS STATUS.O - .15 STATUS Status data received from target device

- STATUS value analysis

Lower bit

OC oT

(For more information, refer to the user manual of the ground rectifier.)

CV Remotoperate 0 bit => Operated (high: Exporting, low: No export)

loJofJoJofofas[a]1]

7
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2 1 0 Bit

1 bit => Remote (high: Communication control,

low: Local control)

2 bit => (high: CV, low: CC)
3 bit => (high: Error, low: No Normal)

4 bit => (high: Error, low: No Normal)
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